
MIDI Made Music Jukebox for Windows Index 
This Index lists the Help topics available for the MIDI Made Music Jukebox.

To learn how to use Help, press F1 or choose Using Help from the Help menu. 

Menu Commands
File
Options
Modify
MIDI Devices
CD-Audio

Other Help Topics
Playing Controls
Creating Song or Video Clips
Adding MIDI, Wave, and Video Selections to Jukebox
Deleting Selections from Jukebox
Setting up the Sound Board or MIDI device
MIDI File Information
MIDI Mapper Information



LLERRAH Inc.'s MIDI Made Music Jukebox player for Windows plays MIDI, Wave music on 
your PC sound board in background while you work in Windows.

* Special features include random and repeat play
* Create personal play lists of your favorite selections
* Plays MIDI, Wave, Microsoft Video and CD-Audio formats
* Speed up or slow down songs by changing Tempo
* Create song and video clips using custom edit feature
* Add up to 5000 of your own selections to the MIDI Made Jukebox
* Simple to use, provides endless entertainment

LLERRAH Inc. develops Windows based Multimedia software and custom MIDI songs to 
meet individual, business, and educational needs.    For more information contact:

LLERRAH Inc.
2701    W. 15th St.    Suite 631
Plano,    TX    75075
(214) 422-1122

EMAIL Addresses:
Compuserve: 75260,1524
America Online: LLERRAH
Internet: LLERRAH@aol.com



File

The File menu includes commands that enable you to open and save files containing MIDI 
Made Music selection lists (.MMJ files).

For more information, select the File menu command name.

Load Play List
Save Current Play List
Exit



Options

The Options menu includes commands that enable you to change playing options and add or
remove selection groups.

For more information, select the Option menu command name.

Random Play
Repeat Play
Create New Group of 10 Selections
Delete Current Group of 10 Selections
Drag and Drop New Selections
Color Schemes
Animation



Modify

The Modify menu includes commands that enable you to modify group names, selection 
information, and your Multimedia configuration.

For more information, select the Modify menu command name.

Name of Current Group
MIDI Selection 1 to 10
Microsoft MIDI Mapper
Multimedia Drivers
System Sounds



MIDI Devices

Select MIDI Devices from the menu to get a list of all MIDI devices currently installed on 
your PC.    You should always use the default, MIDI Mapper, when playing any of the MIDI 
Made Music songs.    Other MIDI devices listed are primarily intended for use when playing 
songs not designed for Windows.    You can play MIDI Made Music songs using the other 
MIDI devices but they may not produce the intended sound.

For best results, use the MIDI Mapper.    See section on the Microsoft MIDI Mapper for more 
information.



CD Audio

If you have a CD-ROM drive on your computer, the MIDI Made Music Jukebox player can 
play music tracks from your favorite audio CDs.    First insert your favorite artist's CD into 
your CD-ROM player.    Next select CD-Audio from the main menu and pick either Play All 
Tracks or Select Tracks to Play.    Select Tracks to Play allows you to pick the individual 
CD tracks you wish to be added to the Playlist.    While the CD track is playing, you can use 
the Time Scroll bar to move forward or backward within the CD track.



Setting up the Sound Board or MIDI device

If you have not already done so, you need to install the Windows 3.1 Multimedia Extensions 
drivers for your sound Board or MIDI device.    Drivers and installation instructions are 
provided by the manufacturer of your sound board or MIDI device.    On most sound boards, 
the installation program configures everything needed to run MIDI Made Music for Windows 
without modification.    If you have any problems with the operation of your sound board, be 
sure to check to see if you have the latest drivers from your board manufacturer.

Refer to the Microsoft MIDI Mapper section if you have problems or questions on the 
operation of your Sound Board with MIDI Made Music.



MIDI File Information

All of the MIDI song files contained in MIDI Made Music for Windows were authored to 
Microsoft Windows 3.1 Multimedia Extensions guidelines.    These guidelines call for two 
performances of each song to be included in a MIDI file.    One performance for higher end 
sound boards and keyboards (MIDI channels 1 through 10) and one performance for lower 
end sound boards (MIDI channels 13 through 16).    This enables the same MIDI file to be 
played on a wide variety of sound boards and MIDI devices without being modified.    Most 
sound board installation programs configure Windows for either high end or low end 
operation.



Creating Song and Video Clips

MIDI Made Jukebox gives you the capability to easily create your own custom song and video
clips.    Song clips are created by modifying existing songs to change start and stop times as 
well as tempo.    For example you could create a 10 second clip of Scott Joplin's "Maple Leaf 
Rag" by specifying that only the first 10 seconds of the song play.    Whenever you play this 
new song clip you will hear only the first 10 seconds of the Entertainer.

When creating a song clip it is recommended that you first add a new song to the Jukebox.    
Since the song clip is a new version of an existing song it should be treated as a whole new 
song.

To create a custom song clip, select Modify - Number of selection to modify from the 
menu or click the Right Mouse Button on the desired selection Icon.    If no file has been 
specified then select a song using the Browse button.    Next select the Custom Edit button
which brings up the custom edit display.

The Custom Edit display has sliding controls to allow you to specify new start and end times 
as well as a new tempo.    To specify a new start or stop time, use your mouse to move the 
sliding controls to the desired times. The tempo is changed in the same way by using your 
mouse to slide the tempo control to the desired tempo value.

If custom editing a Microsoft Video for Windows clip, you can specify a start and stop time, 
the playback speed and the size and location to playback the video.    Use your mouse to 
position the video playback windows to the desired size and location on your screen.

MIDI Made Music Jukebox Player will not use the your custom edit song modification 
unless you activate them by selecting the Activate User-defined Start and Stop 
Times ,the Activate User-Defined MIDI Tempo Settings or the Activate User Defined 
Video for Windows Settings. 

Use the Defaults button to reset start and stop times, tempo values, and video settings 
back to their original values. Select the OK button once you have finished customizing the 
song.

For detailed steps see Example of Creating a Song Clip



Glossary

clipboard



Loading Play Lists

To load one of your Personal Play Lists select File-Load Play List from the menu or select
the Get List button in the upper right hand corner of the main screen.    Select any of the 
files ending in .MMJ to load and choose OK.    The list of selections in the .MMJ file will be 
added to the PLAYLIST.    Note: You can also use the Windows File Manager Drag and Drop 
to copy .MMJ, .WAV, .AVI, .MID, or .RMI files to MIDI Made Music Jukebox player.



Save Current Play List

Personal Play Lists are collections or your favorite MIDI songs, Wave, Videos, CD-Audio 
tracks and/or song clips.    You can save Personal Play Lists to files for later playing.    Create a
Personal Play List by doing the following steps:

1.      Add the selections in the order you desire to the PLAYLIST (You might want to STOP the 
current selection playing in order to keep the PLAYLIST intact)
2.      Save your Personal Play List by selecting File - Save Current Play List from the 
menu.    Enter a file name ending in .MMJ to save your play list.    That's It!



Exit Command

When the Exit command is selected, MIDI Made Music Jukebox player stops playing the 
current selection and ends the program.    If any changes have been made then you will be 
prompted to save them.



Random Play

Random play does just what the name implies, it randomly plays all the selections currently
contained in the MIDI Made Music Jukebox player.    Random play is activated by selecting
menu commands, Options - Random Play, or by pressing the F9 key.    When active, 
[Random] appears Title bar.    Note: Random play only works if there are NO selections in the 
PLAYLIST.    That is after all selections in the list have finished then Random play starts.



Repeat Play

Repeat play also does just what the name implies, it repeatedly plays all the selections 
currently in the PLAYLIST.    Repeat play is activated by either selecting it from menu 
Options - Repeat Play or by pressing the F10 key.    When active. [Repeat] appears in the 
Title bar.    For example, if    two songs are in the PLAYLIST then those same two songs will 
play over and over again.



Create New Group of 10 Selections

MIDI Made Music Jukebox player supports up to 500 selection groups.    Each group 
contains 10 selections.    You can add additional groups to the MIDI Made Music Jukebox 
player in order to add your own MIDI, Wave, or Microsoft Video files.    To create a new group, 
select Options - Create New Group of 10 Selections from the menu.    You can now add 
your own selections in this new group.



Delete Current Group of 10 Selections

Selection groups may be deleted by selecting Options - Delete Current Group of 10 
Selections from the menu.    This will delete the group of 10 selections currently displayed 
on the screen.    

Note: MIDI, Wave, and Microsoft Video files are not deleted from your disk, just the 
references in MIDI Made Music Jukebox player.



Drag and Drop New Selections

Windows File Manager can be used to easily add new selections to the Jukebox and Playlist.   
From the menu select Options - Drag and Drop New Selections which will bring up the 
Drag and Drop Options.    You can select to add Drag and Drop files to either the Jukebox, 
Playlist or both.

Example:    To add the CANYON.MID MIDI file included with Windows to the MIDI Made 
Music Jukebox player do the following:

1) Bring up Windows File Manager and change the Windows directory.
2) Locate the CANYON.MID file.
3) Move your mouse pointer over the file and hold down the right mouse button.
4) While holding down the mouse button, drag the mouse pointer over to the MIDI 

Made Music Jukebox Player and drop the file.    That's It!



Animation

The MIDI Made Music Jukebox player allows customization of the two animation display 
areas.    To modify Animation settings select Options - Animation from the menu or press 
your Right Mouse button over one of the animation areas.

By default the current 10 selection ICONS float over the Treble Clefs.    If you click your left 
mouse button on one of the moving ICONS you will see the ICON change as well as hear a 
sound.    MIDI Made Music Jukebox player allows you to change mouse click actions, the 
number of ICONS displayed, the animation background and even create a moving 
background.

Have fun playing with the animation options!



How to Order Full Release

MIDI Made Music for Windows Order Form:

Name: ____________________________________________________

Company: _________________________________________________

Address: __________________________________________________

City, State & ZIP: ___________________________________________

Country: ___________________________________________________

Obtained Preview Version from:      __CompuServe      __American OnLine    __Other____________

Your EMAIL Address: ________________________________________

Type of Sound Card: _________________________________________

Payment:
MIDI Made Music for Windows Full Version $29.00

Free Shipping in USA otherwise add $4.00 ______

Texas Residents must add 7.25% Sales Tax ______

Total ______

Please send payment to:

LLERRAH Inc.
2701 W. 15th St. Suite 631
Plano, TX    75075
(214) 422-1122

Checks or money orders only in USA funds.    Sorry, but we cannot accept credit cards at this 
time.    MIDI Made Music for Windows comes on 3.5" HD diskettes unless otherwise specified.

LLERRAH Inc. can be reached via EMAIL at the following addresses:
Internet: LLERRAH@aol.com
Compuserve: 75260,1524
America Online: LLERRAH

Thank you for choosing MIDI Made Music for Windows!

Comments/Suggestions:



Modify Name of Current Group

Modify the name used to describe the currently displayed group of 10 selections.



Modify Selection Information

The Selection Information can be added or modified as follows:

1. Add or change Selection Title

2. Pick an ICON that will be associated with the selection by choosing the ICON 
button.

3. Enter the Filename or pick Browse to locate a .MID, .WAV or .AVI file type.

4. Optionally enter information about the selection.

5. Optionally perform a Custom Edit on a MIDI(.MID,.RMI), Wave(.WAV), or Microsoft 
Video (.AVI) file to modify playing times, MIDI tempo or video playback.

DELETE button will remove the selection from the jukebox but WILL NOT delete the actual 
selection file.

Next Selection button will save the current settings and take you to the next selection in 
the current group.



Modify Multimedia Drivers

This option will bring up Windows Drivers option which is used to install, remove, and 
configure drivers that control additional devices, such as sound cards and video players, that
you add to your system. 



Modify System Sounds

This option will bring up Windows System Sounds option which is used assign sounds to 
different system and application events. For example, you can select a sound to play 
whenever you start Windows. The sounds you can assign are stored in files that have 
the .WAV extension. 



Modify Color Scheme Used

The MIDI Made Jukebox provides 3 pre-defined color schemes to select from.    You may also 
select Windows defaults to use you own color scheme.



Playing Controls

The following lists a summary of the playing controls available on the MIDI Made Music 
Jukebox player main screen.    Short-cut keys are listed in parenthesis( ).    To modify a 
selection, click your right mouse button on top of the selection ICON.

Play All (A) Add current group of 10 selections to the Playlist

Get List (G) Get a pre-saved list of selections to add to the Playlist

Next (N)      Play next selection in Playlist or play highlighted selection

Delete (D) Delete next selection in the Playlist or delete highlighted selection

Clear (C) Clear all selections in Playlist

Pause (P) Pause the playing of the current selection.    Hit pause again to resume 
playing.

Stop (S) Stop the playing of the current selection

Play (Y) Start playing the next selection from the Playlist.

1 to 10 (Use 0 for 10) Add Jukebox selection to the Playlist.

Change Time (T) Use mouse or arrow keys to change the current position of a playing 
selection

Change Tempo (O) Use mouse or arrow keys to change the current tempo of the playing 
MIDI song.    Note: You cannot change the Tempo of .WAV or .AVI files.

Next Group (F8) Change to the next group of selections

Previous Group (F7) Change to the previous group of selections

Random Play (F9) Randomly play all selections in the jukebox.

Repeat Play (F10) Play all selections in the Playlist over and over again.



Information on Microsoft's MIDI Mapper

Microsoft's MIDI Mapper is a software device built into Windows 3.1 and above that provides 
means for device-independent playing of MIDI music.    This allows MIDI music to produce its 
intended sound when played through different types of sound boards, keyboards, and other 
musical instruments.    All of the MIDI songs in MIDI Made Music were designed to play 
through the MIDI Mapper.

Luckily, you do not need to understand the MIDI Mapper to be able to use it.    Most sound 
boards correctly configure the MIDI Mapper when you install the Windows 3.1 Multimedia 
Extensions drivers for that sound board.

Generally you should never have to edit any parameters in the MIDI Mapper unless you have
an external keyboard connected to a MIDI port on your PC.    You will have to contact your 
keyboard manufacturer to get instructions on how to modify the MIDI Mapper to work 
correctly with your keyboard.    

If you do edit parameters in the MIDI Mapper, then it is best to make a backup copy of the 
MIDIMAP.CFG file located in your WINDOWS\SYSTEM directory.    In case you incorrectly 
configure the MIDI Mapper, the backup will provide a way to restore the original values.
 
To start the MIDI Mapper select Modify - Microsoft MIDI Mapper from the Jukebox menu.

One point to remember when working with the MIDI Mapper is that all MIDI Made Music 
songs contain two performances of the same song in one file.    You will need to have either 
channels 1 through 10 active for extended level synthesizers or channels 13 through 16 
active for base level synthesizers.    You do not want to have all channels active when playing
MIDI Made Music, this might result in a less than desirable sound.



Example of Creating a Song Clip

The following shows the steps needed to create and add a custom song clip to the MIDI 
Made Music Jukebox player.    This example will perform a custom edit on Scott Joplin's 
"Maple Leaf Rag."

1.      First add a new group of 10 selections to the Jukebox by selecting Options - Create 
New Group of 10 Selections from the menu.

2.      Next select Modify - MIDI Selection 1 from the Menu to add a new song.

3.      Use the Browse button to locate the song we want to customize.    The Maple Leaf Rag 
MIDI file is named MAPLE.MID.    Give the song a title if you wish.    In this example we will call
our new song "Maple Leaf Rag Clip."

4.      Select the Custom Edit button to make the song modifications.

5.      Use your mouse or keyboard to set a new start time of 35.64 and a new stop time of 
49.43.    These times determine where the new song clip should start and stop.

6.      Use your mouse or keyboard to set a new tempo value of 270.    This will speed up the 
playing of the Maple Leaf Rag Clip to make it sound more lively.

7.      Select Activate User-Defined Start and Stop Times and select the Activate User-
Defined Tempo Setting.    Select OK to save your custom edit song settings.

8.      The new values for start and stop times and tempo will be displayed next to the Custom
Edit button on the Modify Information display.    This informs you which custom settings the 
song will be using.

9.      Select the OK button to add your song clip to the MIDI Made Music Jukebox player.

10.      You are finally    ready to play your new song clip by simply selecting    ICON button  on 
the main MIDI Made Music Jukebox display.    Upon exiting the MIDI Made Music 
Jukebox player be sure to save your changes in order to keep your new song clip.



Addiing Selections to the Jukebox

You can add your own selections to the MIDI Made Music Jukebox player with a few 
simple steps.    From the menu select Modify - number of selection to modify or click 
your right mouse button on the selection ICON.    You will be prompted to enter a Selection 
Title, pick an ICON, and enter the full path name of the MIDI, Wave or Microsoft Video file.    
You can optionally fill in selection information field as well as doing a Custom Edit of the 
selection

To add or change the selection filename you will need to select the Browse button.    This 
will bring up a window that will allow you to locate a MIDI, Wave or Microsoft Video file to be 
added to the Jukebox.    After you have entered a valid file name and Title then select OK to 
update the Jukebox.    Be aware that the changes made are not permanent unless you save 
changes when you exit MIDI Made Music Jukebox player.



Deleting Selections from the Jukebox

To delete a selection from the MIDI Made Music Jukebox player, select from the menu 
Modify - selection number to delete.    Select Delete to delete all the text associated with
the selection.    Select OK which will delete the reference to the selection.    

Note: This will not delete the selection file name off your harddisk.    Only the reference to 
the selection will be deleted which will not be permanent unless you save changes when you
exit the MIDI Made Music Jukebox player.



 Thanks to the Harrell Team:

Marjorie Harrell, Bill Harrell, Brenda Harrell, Lisa Harrell, John Harrell, Laura Harrell, Stuart 
Harrell and of course Lainey Harrell
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